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4   Introduction

Bringing 
designs to life

A
dobe Illustrator has been a mainstay in the workflow 

of graphic designers for years now. Over time, there 

have been some changes. However, the basic funda-

mentals of the program have remained the same over 

time. In various industries today, with the increasing demands of 

the online world and the changing landscape of advertising and mar-

keting, known the basics of Adobe Illustrator has become a norm.  

        There are multiple tools available on the internet, like Canva and the like, 

which provide a wide range of functionality that has been abridged from 

Illustrator. However, when it comes to making custom content for clients, 

there is no doubt that the capabilities of Illustrator are unrivalled. So, in 

this FastTrack, we will give you a quick overview of the basic functionali-

ties of Adobe Illustrator and take you through some of the basic tasks, like 

making logos and infographics, equipping you with sufficient knowledge 

of the program and its capabilities in the process. So, if you are an amateur 
artist looking to start your journey to work on Illustrator or a seasoned 

veteran, we have something in store for everyone.

Programs like Illustrator, no matter how well you think you have mas-

tered them, tend to throw a curveball your way at times. There have been 

They say give words to your 
thoughts... We say draw ‘em!
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several instances while writing and proofing the book that some members 

of Team Digit were presented with new and efficient ways of doing stuff 

which they had normally been doing without giving a second thought. And, 

as Steve Jobs right said, and we quote - “Learn continually - there’s always 

‘one more thing’ to learn”. So read this book from cover to cover, and who 

knows, you may stumble upon some things that you never thought were 

a part of Adobe Illustrator. And, if you are a newbie, who is looking to get 

started with the program, then this is the perfect book for you. As stated 

earlier, we have included step-by-step tutorials where we walk you through 

processes like making and inserting graphs and designing logos and ban-

ners only using the tools available in Adobe Illustrator. 
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First steps

T
his book as you would know is aimed at teaching you the dif-

ferent ways in which you can make use of Adobe Illustrator in 

the least possible time.  We’d proceed to the in-depth specifics of 

this programme as soon as you have mastered the fundamental 

concepts. By the conclusion of the chapters, you’ll not only be proficient at 

using Illustrator technically, but you’ll also have learned a tonne of design 

and illustration theory and techniques.

What is Adobe Illustrator?
Adobe Illustrator is a computer graphics program designed by Adobe Inc. 

that enables users to create intricate layouts, patterns, and drawings. One 

of the numerous Adobe inventions that changed graphic design was Illus-

Embarking on the journey to making 
graphics using Illustrator...
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trator, which debuted in 1987. It is a software programme for producing 

drawings, illustrations, and artwork. This programme is still being regu-

larly updated, and it is currently a part of the Adobe Creative Cloud. Visual 

artists, professional illustrators, web designers, and graphic designers 

all around the world utilise Illustrator to produce high-quality artwork. 

There are several intricate drawing tools in Illustrator that help speed up 

the graphic creation process.

What are the main features/uses of Adobe Illustrator?
For designers, Adobe Illustrator is a powerful programme that offers a 

variety of features and capabilities. The following are some of Illustrator’s 

primary abilities:

1. 	 The capacity to create freehand drawings using a range of digital pens, 

pencils, and brushes.

2. 	 For designing colour palettes, filling shapes, employing gradient colour 

schemes, and combining other colour effects, advanced colour choices 

are available.

3. 	 You can divide the elements of your design into multiple levels using 

the “Layers” function, which makes it simple to alter one layer without 

affecting the others.

4. 	 You can accurately align objects and lines with ease using a grid feature 

with anchor points and “snapping” features.
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5. 	 To make it simple to start up a project in the middle of it, there are cloud 

libraries where you can collect and save all of your design materials for 

it, including colours, brushes, images, text, and character styles.

6. 	 A font collection with a search function so you may locate the ideal font 

kinds to employ for your projects.

7. 	 It has tools for swiftly drawing geometric objects, modifying curves, 

and adjusting lines.

What purposes does Adobe Illustrator serve?
Digital artwork, promotional or branded content, icons, website images, and 

more are frequently produced with Adobe Illustrator. It is popular among 

artists who produce digital art for both personal and commercial purposes, 

as well as in the corporate sector for graphic design tasks linked to branding, 

marketing, and advertising. Because it creates vector-based graphics rather 

than raster-based images, graphic artists frequently favour Adobe Illustrator 

over Adobe Photoshop and other photo editing applications.

Navigating the UI and general workspace of Illustrator
The most essential tools are conveniently located in Illustrator’s pri-

mary workspace. This makes it simple for you to locate the tools you 

want without having to search through menus. Additionally, Illustrator 

enables users to use these capabilities more quickly by using basic 

keyboard shortcuts.

•	 Toolbar - Gives users access to several tools with a wide range of 

image-editing features. Typically, these instruments are used for 

sketching, painting, measuring, selection, typing, retouching, and 

navigation. The tool symbol for some tools has a little triangle in the 

bottom right corner; these  Similar tools can be revealed by expanding 

a tool.

•	 Control Panel - Provides extra options for the tool you’re presently 

using in conjunction with your toolbar. Depending on the tool you 

are using, the options bar varies. 

•	 Menu Bar: The menu bar offers options for doing frequent tasks. It 

offers nine menu choices: Type, Select, Effect, View, Window; File; 

Edit; Object; and Help. An ellipsis next to a menu option means a 

conversation box will appear after it. Arrows on menu items denote 

a submenu for that specific choice.

•	 Panels - Assists you in monitoring and editing your work. It offers 
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groupings of features tailored to particular tools or tasks. Panels may 

be moved and adjusted to create a unique workstation.

What are the latest features of Adobe Illustrator?

Make a list using the text.
Now you can simply utilise numbered and bulleted lists. You can add vari-

ation to the language that you use for your designs. Both lists, in sorted 

and unordered formats, assist your readers in locating the essential ideas 

in the text.

Control states with the history panel.
You may access any recent stage of the design you generated during the 

current working session by using the history panel. You can see new states 

being added to the history panel whenever you add any design components.

Enlarge items as wireframes
To ensure correctness, see your 3D object’s underlying structure using 

wireframes. Wireframes can also be exported as line drawings for later use.

Export coloured 3D objects
3D models may now be exported as OBJ files with colour information. 

You may see each item as a separate, changeable entity when you export 

several objects.
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Vectorization of map artwork
Along with the 3D object, map artwork may now also be rendered as a 

vector graphic.

What is Adobe Creative Cloud?
With the help of the user-friendly, high-quality software programme Illus-

trator CC, you can produce outstanding drawings and illustrations in the 

most widely used file format in use right now, the PDF format. The Adobe 

Illustrator CC basic user interface is largely similar to earlier iterations. 

To create your project, choose from the “create” and “draw” tools. With the 

functionality included in this edition, you may change content that has 

already been placed into the file as well as add text boxes and links. The 

program’s numerous unique effects give your photographs a stunning 

appearance. Gradients, path selection, clipping paths, and masking tools 

are among the most used features. With Illustrator CC, a wide range of file 

formats, including EPS, PDF, TIFF, and PSD, may be produced. The file will 

instantly show as layers in Adobe Photoshop when you select to open one 

of these formats, which you may then modify as you see appropriate. Then 

you may mix them to make stunning designs. To choose the ideal software 

for your project without spending excessive amounts on sophisticated 

features, be sure to educate yourself on the many styles of graphic design.

Using Illustrator with the Creative Cloud
Illustrator can be licenced alone or as part of an Adobe Creative Cloud 
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subscription. Since Illustrator is a part of the Creative Cloud, it may be used 

to share artwork with other Adobe Creative Cloud programmes including 

After Effects, Photoshop, InDesign, and Premiere Pro. It is common for 

users to produce their original artwork in Illustrator first, then import it into 

Photoshop or After Effects. A picture created with Illustrator may also be 

exported to InDesign and then used in a book or magazine. To animate an 

Illustrator artwork, users can also export it to After Effects. The same is true 

when importing artwork from Photoshop into Illustrator, where a finished 

design may be put together by combining text, images, and other elements.

Adobe Illustrator vs Adobe Illustrator Creative Cloud
The two versions of Illustrator, CS and CC, are quite similar yet distinct. 

Before choosing one, you might want to consider the following points.

What has changed in CC over CS6 ?
1. 	 Every year, Illustrator CC updates its feature set. You can always get 

the most recent update.

2. 	 You can access more Adobe products like InDesign, Photoshop, After 

Effect, Lightroom, etc. with a CC membership.

3. 	 Illustrator CC now 

offers practical new 

tools, presets, and 

even templates. These 

wonderful features can 

help you save time.

4. 	 The Cloud is really 

fantastic. Your docu-

ments’ styles, presets, 

brushes, fonts, and 

other elements may 

all be synced.

For graphic design, 

both Illustrator CC and 

Illustrator CS6 are excel-

lent. The primary distinc-

tion is that the CC version 

uses modern cloud tech-

nologies. Additionally, Photo retouching services
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the membership plan enables you to utilise additional Adobe products, as the 

majority of designers employ many applications for their work.

The most popular version currently is Adobe CC. Just be aware that you 

won’t receive any new updates or bug patches for your software if you currently 

own a Creative Suite programme or decide to buy a CS version.

What file formats Illustrator can work with?
Since Illustrator can produce and edit vector pictures, it is necessary to save 

files in vector graphics formats. Scalable Vector Graphics (SVG), Encapsu-

lated PostScript (EPS), Portable Document Format (PDF), Windows Metafile 

(WMF), and Vector Markup Language (VML) are a few of these formats, 

and they are described in more depth below.

Illustrator is able to export files in PDF format. It enables text and 

graphics to appear regardless of the operating system, programme, or 

hardware. Fonts, images, and text are all included in a comprehensive 

description of flat documents having a set layout. These components are 

combined and compressed into a single file using the organised storage 

system that is part of the PDF format. Additionally, it has a mechanism for 

linking fonts to documents and a subset of PostScript to create the visuals.

The PostScript subset known as EPS has additional limitations that 

make it possible to store graphic files. These files can be enclosed within 

another PostScript file and are often self-contained. A low-resolution pre-

view of the image is contained in an EPS file, which certain applications 

may show as a PostScript programme. In earlier times of its existence, it 

was typical to save Illustrator files into an EPS format before sharing them 

with tools for page layout.
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The PostScript subset known as EPS has additional limitations that 

make it possible to store graphic files. These files can be enclosed within 

another PostScript file and are often self-contained. A low-resolution pre-

view of the image is contained in an EPS file, which certain applications 

may show as a PostScript programme. In earlier times of its existence, it 

was typical to save Illustrator files into an EPS format before sharing them 

with tools for page layout.

In the 1990s, Windows started using the WMF file format, which Illus-

trator could export to. This format may be utilised similarly to the SVG 

format because it can hold both bitmaps and vector drawings. There is a 

list of functions in WMF files.

The Windows Graphics Device Interface (GDI) employs a set of function 

calls from WMF files to show a picture. Since some GDI methods handle 

errors, a WMF can contain executable code.

VML was an Office Open XML standard that used an XML-based format 

for two-dimensional vector graphics. Since 2012, Internet Explorer has 

stopped supporting it, however, it is still present in Office Open XML for 

historical reasons and was once supported by Illustrator.

Since 1999, the World Wide Web Consortium (W3C) has maintained the 

SVG specification as an open standard. The Extended Markup Language 

(XML) on which this format is based allows two-dimensional graphics for 

both animations and interactive pictures. XML files that specify SVG images

Illustrator can save and export other file formats too!

The following formats can be exported from Illustrator:
1. 	 AutoCAD Drawing (dwg)

2. 	 AutoCAD Interchange (dxf)

3. 	 Enhanced Metafile (emf)

4. 	 BMP (bmp)

5. 	 JPEG (jpg, jpe, jpeg)

6. 	 Flash (swf)

7. 	 Macintosh PICT (pct)

8. 	 GIF

9. 	 PNG (png)

10. Text Format (txt)

11. 	Photoshop (psd)

12. 	Targa (tga)

13. 	TIFF (tif)
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Pricing of Adobe Illustrator
Direct downloads of Illustrator CC are offered by Adobe. Either the indi-

vidual application or the entire Creative Cloud application suite requires 

a subscription. The cost of a monthly licence for the individual Adobe 

Illustrator programme is $19.99, or $17.99 with an annual subscription. 

Customers who use a prepaid plan get a 20 per cent discount off the $49 

monthly fee for using the whole Creative Cloud software.

Directly from Adobe is where you can get Illustrator CC. Either the 

particular programme or the entire set of applications included in the 

Creative Cloud requires a membership. For $19.99 per month on a monthly 

basis or $17.99 per month with an annual subscription, the standalone 

Adobe Illustrator programme is licenced. Customers who use a prepaid 

plan save 20% off the monthly fee of $49 for access to the whole Creative 

Cloud app.

Which system is the best for Adobe Illustrator?
Some designers choose to utilise just Apple products due to the historical 

Mac legacy. Some people are accustomed to and like the user-friendly 

interface, while others appreciate how Apple products work together 

seamlessly. 

One benefit of Macs is that they frequently come with high-end hardware, 

so you don’t necessarily need to worry about understanding how to fix it. 

After installing the apps, you may immediately go to work. It is simple 

to switch between devices within the Adobe Creative Cloud due to the 

strong integration of Apple technologies. Even certain features and appli-
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cations have been created 

especially for iPads and 

other Apple gadgets. 

On the other side, many 

believe Windows is 

more reasonably priced 

for comparable items of 

high quality. 

With Windows 

devices, you may fre-

quently get more options 

and the opportunity to 

modify the hardware 

for less money than you 

might pay for a Mac. 

Because there are addi-

tional storage choices 

with Windows PCs, 

some designers also 

find them to be advanta-

geous. Because Windows 

is more flexible out of the 

box, it’s simpler to switch 

graphics cards and hard 

drives on Windows than 

it is on a Mac for pho-

tographers or designers 

who want continually 

top-of-the-line graphics 

and large quantities 

of storage.

Because it was the 

only option available for 

a long time, designers 

and Adobe users pre-

ferred Mac computers. The quality wasn’t as good for a long time, even 

after Windows debuted as a competitor. Since the introduction of Adobe 

software in the 1980s, Macs have regularly produced high-quality work.
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But since then, technology has advanced significantly. Today’s Windows 

products are of a calibre that rivals those of Macs. The type of machine you 

purchase to run Adobe Creative Cloud programmes no longer really matters 

as long as you know what you need.

Conclusion
One of the greatest vector editors available, Adobe Illustrator CC has cutting-

edge features and new tools that let you swiftly produce original ideas. There 

are numerous resources accessible to beginners to teach them how to use 

Adobe Illustrator. Beginners may find Adobe Illustrator lessons daunting, 

but once you get the hang of it, utilising the workspace will be simple and 

you will be able to produce some amazing designs. 
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Making a logo 
in Adobe 
Illustrator

Y
our text logos are believed more memorable if you use a 

readable, straightforward, and stylish typeface. Minimalist 

logos and designs have seen a resurgence in popularity 

over the past decade, partly because of their adaptability 

and ease of implementation. A simple logo can successfully represent 

your company on a business card.

Design your own version of the 
famous swoosh!
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To simplify things, in this chapter we will walk you through the steps 

of making a simple text logo. We hope the following tutorial will be helpful 

and provide inspiration whether your goal is to design a logo in the manner 

of a bygone era, in three dimensions, or in cartoon form.

You can use Illustrator to make 

a unique text logo if you want one. 

This chapter will teach you how to 

use Adobe Illustrator to alter letter-

forms, combine letters and words 

to build new and exciting shapes, 

and effectively use negative space. 

We’ll talk about why it’s crucial to 

experiment with your text logos in 

terms of size, alignment, typeface, 

colour, and more before you’re sat-

isfied with the final product.

Tips for Creating a Text Logo in Illustrator
This section will walk you through Illustrator’s ten essential processes for 

making a text logo, from concept creation to final print export. But first, let’s 

get the fundamentals straight.

As was previously noted, the brand for whom you are creating the logo 

will determine whether or not you:

•	 First, convert the company name into a text logo.

•	 Construct a text logo using a two- or three-letter abbreviation of the 

complete name.

If you want to play around with the complete name (which could be 

one or more words), make sure you know if you’re just allowed to use the 

acronym. You should figure this out immediately so you don’t waste time 

making a text logo that won’t be approved.

Sometimes you may even be allowed leeway to try out different combina-

tions of the abbreviation and the full name and then explain your findings. 

Your brainstorming session will be much more effective if you know this. 

As soon as you’ve settled on the specific style of text logo required, you can 

begin developing an initial concept.

Conceive Possible Solutions
As with any creative endeavour, it’s best to give yourself time to think things 
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through before diving headfirst into Adobe Illustrator’s vast array of fonts 

and shapes. So, relax, and try to think outside the box.

If you find that brainstorming on paper is more productive for you, 

then, by all means, use that method instead of a computer. Honour your 

way of coming up with ideas. You understand better than anyone else 

how to stimulate your imagination.

Use a whiteboard or a sketchbook to brainstorm potential logo 

designs incorporating the word (or words). Consider combining, over-

laying, or chopping up your two or three letters to create a new, more 

“modern” letter.

To illustrate, say you need to create a logo incorporating the initials 

“M” and “W.” The letters “M” and “W” can go anywhere. Because of 

the similarities between these two letters, we used them as an illus-

tration. The letter M, when inverted, forms the letter W, albeit with 

straight “arms.” 

Overlapping or positioning these letters so that the “M” resembles 

the “Wshadow “’s works well. However, in the real world, you won’t be 

able to pick the letters that are the simplest to work with or that are the 

most similar to one another. You may have to combine the letters “M” 

and “P” or “O” and “L” and “Z.” But no matter what the brand’s name 

is or what initials you’re given to work with, there’s always a way to 

make them function and look the way you want them to.

Send Your Concepts to Illustrator
After you’ve done some thinking, open up Adobe Illustrator and begin 

developing your text logo. So, let’s say you’re starting your own photography 

business and need a logo that includes your name, your last name, and the 

word “Photography” in the middle.

Step1:  Create a brand new file

Step 2: You will be asked to type in your full name in the second stage. 

Put “Photography” in quotes after your full name.

Step 3: Set the text aside from the document you’ve made so you can 

refer to it as a foundation and keep it in plain view.

Step 4: You will make a copy of your full name by clicking it, holding it, 

dragging it, and dropping it into the newly created document. One of your 

full names will be duplicated.

Step 5: If necessary, adjust the size. Expanding the name can give you 

a better idea of how it will look after experimenting with different fonts.
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Choose the Appropriate Font
Now that you have an idea of the overall aesthetic you’re going for, it’s time 

to experiment with different typefaces.

The logo’s meaning should be considered when selecting a font. Any font 

that you feel best captures who you are and your work should be used for 

any logo you might need to design.

If that’s how picky you want to be, then by all means. Learning about 

and downloading alternative fonts could be worthwhile if you intend to use 

this logo for decades. If you’re tasked with creating a text logo for another 

person or company, you’ll need to put aside your tastes to select the most 

effective typeface.

If the business is a tattoo parlour, you may want to experiment with 

gothic fonts, traditional ones like Old English, or more contemporary ones 

like Futura.

Avoid using fonts that are too fancy or difficult to read if the business is 

a jewelry shop. Try something understated and elegant instead.

The Cartier text logo is one of 

our favorites when it concerns 

projects in the jewelry industry. 

More than 12 decades have passed 

since the debut of its timeless, 

minimalist logo.

Cartier has been using the 

same font for its logo since 1900. 

It had survived the test of time 

despite being created in an era 

when illustrators and graphic 

designers lacked the typographic 

design tools available to modern-

day designers.

Discover the Variety of Fonts Available
Let’s revisit our original situation where you need a text logo for your 

photography business.

As was mentioned before, your personal preference in how your 

name looks and sounds will be the primary factor in making this 

decision. There are two primary avenues you can take to experiment 

with typography:

So many to choose from
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Option A: Use Adobe Illustrator’s Typekit 
If you don’t have a specific font in mind or have already downloaded it, we 

suggest using Illustrator’s built-in Typekit to browse the available fonts.

Filtering the fonts is a quick way to experiment with them all.

Step 1: Open the Character panel’s submenu by clicking the panel’s 

name at the top.

Step 2: Select “Find more” and then select the first icon to the right of the 

word “Filter.” Classification-based font elimination will occur.

Step 3:  Redesign it to fit your ideal category. As an example, you could 

select the “script font” subcategory.

Step 4: On the same compact desk, beneath the Grouping panel, is 

the Properties panel. The settings for this item can be modified here. For 

instance, you can select the “Heavy Weight” setting if you prefer a bolder font.

Step 5: After applying these two filters, a selection of fonts will appear. 

Try scrolling down the right side if you’re looking for a specific typeface.

Alternatively, you can look for alternative typefaces on the internet.

Option B: You can search for precisely what you need and then 
download your top choices from several websites 
Remember that you should only download fonts licensed for your 

intended use before installing them on any device.

For obvious reasons, if you come across a font that is free for personal 

use but requires a license for commercial use, you can always pay for the 

license and put the typeface to any use you choose.

Once you’ve settled on a typeface, could you save it to your hard drive? 

Installing the new typeface into Adobe Illustrator is the next step.
But before you do that, make sure Illustrator is closed. The newly installed 

fonts won’t show up in Illustrator until you quit the program and restart it.

You won’t be able to use the new fonts unless you close Illustrator first. 

Before continuing, save your current work and exit Illustrator.

For Windows

        Step1:  Launch File Explorer (Win+E) and navigate to your typeface’s ZIP 

folder. The downloaded font file will also be saved in the Downloads directory.

Step 2: Open the compressed folder and access the files inside.

Step 3:  Double-click the font file and select “Install” from the menu at 

the top of the preview window. Step 3 should be repeated for font file vari-

ations, such as bold, italic, etc.
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Step 4: Re-access the Illustrator file you were most recently working on.

Step 5: Choose the font you just installed in the Character panel’s drop-

down menu.

For Mac

     Step 1:  First, launch Finder and navigate to where you saved the font 

file. The Downloads folder on macOS is also where you’ll discover any 

downloaded files, including any fonts.

Step 2: Double-click the ZIP file to extract its contents (if the font file is 

compressed). A preview of the downloaded font will appear.

Step 3: Select all the files you want to extract by pressing and holding 

the “Command” key as you click each one. Select “Install Font.”

Step 4: Click the “Apple” icon in the top left corner of your screen, and 

then select “Restart” to force your Mac to restart.

Step 5: Reopen the previous Illustrator file.

Step 6: Head to the Character panel and select the font from the drop-

down menu.

Allow Yourself Some Time to Readjust
You can now modify and personalize the lettering to your liking after 

selecting a typeface or downloading one that best represents your brand.

Letters can be modified in innumerable ways to achieve the desired shape, 

whether in an abstract form, a simple shape, or a shape in three dimensions.

Feel free to use any font from Illustrator Typekit to practice the following 

steps if you haven’t yet found a typeface that works well with the word or 

words you have to include inside the text logo.

Let’s say you’ve found the perfect font, but you realize you need to adjust 

the length of some of the letters.

You can adjust the size of a letter if you don’t like how it looks. Repeat 

this process until the combination of letters looks good.

Play With Language
After applying the font of your choice to the full name, you should break 

the name into its parts—the last name and the first name—so that you can 

later edit them independently if desired.

Step 1: Choose the surname, press “Command” and “X” to copy it, and 

then paste it on a new layer.

You can now independently change either part of the name.
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Step2: Pick an alignment from the drop-down menu that appears when 

you click “Align” in the main menu.

Step 3: Make multiple logo iterations.

The last and first names are “active” on their own, so you can choose 

whichever you like and squeeze them together.

If you like the outcome, you can merge the two. Then, copy it by clicking 

on it, dragging it to the top of the file, and releasing it.

An alternate direction to test would be to put the surname before the 

first name.

If you go with this route, it will look best if the length of the given name 

and the surname are roughly the same, as this will minimize the amount 

of white space in the four corners.

Step 4: We’ll add some “sophistication” to the name. To access the context 

menu, choose the full name and 

then right-click. One will see a 

small window appear. To access 

“Shear,” go to “Transform.” If 

you click the preview box, a new 

window will pop up where you 

can adjust the “Shear angle.”

You can adjust the “Shear 

angle” until you are happy with 

the result and then click “Ok.” if 

you are not.

Including the Surname
Do you recall that we initially typed in “Photography” as well? It’s time 

to add that piece to your full name now. You can insert it in a straight line 

under your name; to add “character,” try a different font.

To take advantage of the Path Tool, please read the following instructions.

Step 1: on the left-hand side of the screen, below the text box, click the 

rectangle icon and choose the “Ellipse Tool.”

Step 2: once you have decided on the size of the ellipse you want to make, 

click and drag the mouse on the document to make it the size you want.

Put this ellipse in the middle of the full name text logo you made earlier.

Step 3: Click the icon directly above the text to access the “Type on a 

Path Tool,” which will allow you to draw a curved path.

Step 4: Click once to finalize the shape with your mouse cursor at the 
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edge of the ellipse you just made. By clicking this, some lorem ipsum text 

will be added as a closed path around the entire ellipse.

Step 5: After selecting “lorem ipsum,” type “Photography” and align it 

to the center by clicking on the text.

Step 6: Under the full name, put the word “Photography” using the 

brackets. Please ensure that your full name and the word “Photography” 

that appears directly under it are centered.

Step 7: Adjust the font size of the full name or the word Photography.  

And there you are... You have created your first logo using Illustrator! How-

ever, if you are working on your own project and cannot find the perfect 

font to use in your design, then don’t worry. You can create your own fonts 

using Illustrator. In the next chapter, we will tell you how. 
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Create your 
own font

I
f you know how to make glyphs 

in Adobe Illustrator and are a 

designer or Illustrator, this chapter 

is right up your alley. Here you’ll 

learn how to make your font in Adobe 

Illustrator by planning a letter set, going 

over ways to improve the font design, 

and preparing files for use in a font-

making program. All of this will be done 

from the comfort of Adobe Illustrator.

Can’t find the perfect font to use in 
your designs? Make your own!
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You’ll learn how to make a font in this chapter. We will teach you how to 

make your font in Illustrator and make simple, fun fonts that you can sell 

as digital assets. You won’t need a plug-in for Illustrator that lets you make 

fonts. Just look at the fonts section of the market to get ideas for your designs.

How to make a lettering sketch:

Step 1
In this section, we’ll show you how to make your font in Illustrator and 

how to start from scratch when creating a font. Whether drawing letters 

on paper or in a digital art program like Paint Tool SAI, Adobe Photoshop, 

Krita, or another, we like to start by quickly drawing an alphabet in the style 

we want our font to have. Think about how your letters connect.

Step 2: 
You can utilize grid lines in drawing similar like Adobe Photoshop to 

keep your letters from looking like a mess. You can make a Grid Layout 

if you want, or you can put the grid lines in by hand. In a casual setting, 

this lets you keep track of 

the height and width of 

each letter.

Step 3: 
You can also scan in drawn 

or written forms of letter 

and change the Threshold 

like Image > Adjustments 

> Threshold, so the image 

is clean, black and white, 

and ready to be imported 

into Adobe Illustrator. 

This step is optional, as 

you can also draw your 

font by hand in Adobe 

Illustrator or import your 

image without changing it 

in Adobe Photoshop. It is 

essential to remember as 
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you learn how to make your font. In the next part, we’ll learn how to use 

Illustrator to create a font.

How to get your letters and Illustrator files ready:

Step 1
Now we’ll learn how to use Illustrator to make a font. We like to prepare 

my imported image file before we start making vector versions of our let-

terforms. We drew the letters in Adobe Photoshop. Open the jpeg file in 

Adobe Illustrator. In the Image Trace panel, you may want to change the 

following settings:

•	 Preset: Custom 

•	 View: Tracing result

•	 Mode: Black and White 

•	 Threshold: 168

If you have Preview turned on, your drawing will be turned into a vector 

image right away when you click Trace.

Step 2: 
Pick the image you just traced and go to Object> Expand. It will make vector 

objects out of your traced image. Separate the things and use the Magic 

Wand Tool to pick out the ones with white fill. Delete these so that only 

the black letters are left.

Step 3: 
Start a new file. Ours was sized to what we thought was the best size for the 

biggest letterform we wanted to make: 0.55 in by 1.26 in. Of course, you can 

pick the correct file size for your needs.

How to put your letterforms in order

Step 1
Now we’ll keep learning how to use Illustrator to make your fonts. Bring in 

or copy and paste your letterform group into your New Document. Separate 

them so you can control each object on its own. We put Grid lines on top of 

our Artboard to help show where each part of our letterform set ends and 

begins. Uppercase and lowercase letters will have their tops and bottoms 

marked by the lines.
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Put the Object that makes up your first letter on the Artboard. If it doesn’t 

have descenders at all, similar to the letters j, g, p, and y, put it at the baseline 

shown by your gridline.

You can change the size and shape of your letterform within the gridlines 

and Artboard as you see fit.

Step 2: 
Some letters are the same size, shape, and way they are put together. We 

often use the lowercase “b” as a “d,” “p,” or “q.” Also, look at how your 

letters change from small to capital. Everything will be redone in the 

next part of this chapter, so it will be up to you to decide how your letter 

shapes fit together. Write down any changes you want to make before 

refining the letters.

Step 3: 
Each type of glyph (lowercase, uppercase, punctuation, and numbers) is 

placed on the Artboard one at a time, and each type’s layer in the Layers 

panel is named after its category. As we work on each letter, we tend to add 

new things to the layer that goes with it.

Making a font can be a big project, so the more organized you are, the 

easier it will be.

Step 4: 
You must decide how big and where to put punctuation and other special 

characters. Most of the time, numbers will be about the same size as your 

capital letters, but punctuation needs to fit with both capital and small let-

ters. Pay attention to the arrows. We put our asterisk at the top of my font 

shapes, while our plus sign was more in the middle.
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Playing with your letter and glyph objects, you can determine where 

your punctuation should go best. Try different ways of arranging your 

things until you find one you like.

How to Make Your Letters Look Better

Step 1
In this section, we’ll look at different ways to use the Brush Tool to make a 

font. Let’s look at four ways to improve your letters’ shapes.

1. We haven’t done anything. Our letter “s” would look like if we just used 

the image we traced. It’s not smooth, but it has a strange charm.

2. After I used the Shape Tool, we got this next letter shape. It’s been 

cleaned up and made smoother, but it’s still not as smooth as the letters below.

3. The Pencil Tool was used to trace this third one (N). Set your Fidelity 

to Smooth and outline your letters as you see fit.

4. Finally, the Blob Brush Tool looks like (Shift-B). The Brush Tool can 

also give you a similar result (B). Both can be used to make lines work 

with pressure.

If you choose the Blob Brush Tool, you’ll make font Illustrator objects 

for each letter. If you select the Brush Tool, you will make paths you can 

change using different brushes. I’ll use the Brush Tool and a custom brush 

we’ll make next.

Step 2
My custom brush is a Calligraphy Brush with the following options:

•	 Angle: 40° 

•	 Roundness: 51%

•	 6 point font, 6 point pressure range

Please remember that we’re using a graphics tablet that responds to 

pressure. If you are drawing with a mouse or something other than a stylus, 

the Pen Tool (P) is probably a better choice.

Step 3
You’ll learn how to design a font in this step. It’s time to redraw your letters 

and make them better. Set each letter, one at a time, on a layer above your 

lowercase letter group to be visible and draw over them. Our custom brush 

looks like we wrote letters with a chiseled marker. Use similar characters 

to change the way other people look. We used the letter “b” to make all four 
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characters below. Put each letter on top of the one below it, and in the Layers 

panel, hide the ones you aren’t working on.

Step 4
As we went through the alphabet, we changed the overall look of some 

letters. We’ve also ensured that descenders end on a similar line under the 

baseline and that lowercase letters that aren’t h, t, l, or k don’t go above the 

top line of the other lowercase letters.

As always, it’s up to you if your letter shapes follow these rules or not. 

Have fun making things, and use the drawing tools in Adobe Illustrator 

that you like best.

Step 5: 
Fix special characters and punctuation as well. My pound sign also called 

hashtag was too big and skinny for the rest of my characters. So, I re-drew 

it with the Brush Tool to make it overall smaller and rounder.

How to Get the Characters Ready for the Font

Step 1
This section will learn the first steps for switching from vector to font. First, 

look at the final versions of all 89 of my characters for this font. As for what 

We’ve have accomplished thus far, it is as follows:
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•	 Check to see that each letter fits in the same space and uses the same 

gridlines as a guide.

•	 We’ve ensured that every character we want to be in the final typeface 

is just right.

•	 We put all our characters on layers that are easy to find in the Layers panel.

Step 2: 
To export the content to another program, you’ll need to save each glyph 

as its SVG file. We’ve kept the default settings for saving SVG files and just 

made sure that, when we are done, there are 89 files in a folder named after 

characters. 

Step 3
We’ve also done the following for each SVG file to make sure the file sizes 

are as small as possible:

•	 We turned all brush paths into objects using the Expand command.

•	 Objects and layers in each SVG file that can’t be seen (anything but the 

current character) have been removed.

•	 The paths of the objects have been combined in the Pathfinder panel to 

form a Compound Shape, which has been extended to reveal its full length.

Even though these steps were a bit tedious, they reduced the size of our 

file from 800kb to 1kb or like that. From here, you can put your files into. the 

font-making program of your choice and have your fonts ready. 
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The Art of 
Iconography

H
aving custom icons in your design library is a handy thing to 

do. You can find a lot of great-looking icons on the Internet, but 

nothing beats heroes that were made just for you.

If you’ve never made an icon before, you can try it out with 

the steps we have listed out in this chapter. And if you need to learn more 

about making icons, they will help you learn some new tips and tricks.

Icons are an excellent way for new and experienced graphic designers 

to improve their skills.

Shapes and the Shape builder tool are easy for beginners, and making icons 

isn’t usually hard from a technical point of View. You don’t have to use Adobe 

Make everything look better with 
your own custom icons
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Illustrator’s more complicated 

tools, like Effects and Textures, to 

make simple shapes. They’re just 

a fun way to learn the basics of 

Adobe Illustrator’s design tools.

Icon design can still be fun 

and challenging for graphic 

designers who are very good at 

it because it takes a lot of design 

skills to break an icon down to 

its most essential parts.

When you learn how to 

make icons, you have to stretch 

your ability to think creatively. 

It makes you think about what 

you want to include in your 

final icon design and makes 

you stick to a plan.

 
Why use them?
First, let’s talk about what icons 

are and what they do. Icons are 

simple pictures that show how 

ideas, concepts, or objects look. 

From a design standpoint, icons 

have three advantages:

Icons are easier to understand and take less time than words
First, these visuals are usually easier and faster for your audience to under-

stand than text descriptions.

This is especially true for things that can’t be touched or seen, like ideas 

and concepts. It’s easier for our brains to figure out what something looks 

like than it is to figure out what it says.

Our brains are drawn to things we can see. Think about the apps on your 

phone and how you use them. Are you trying to find the word “weather”? 

Or the picture of the sun and cloud?

Why not take pictures? Are you trying to find the word “camera”? Or 

the image of a camera? It’s easier to find and use apps because they have 
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icons that show what they are. 

That doesn’t mean the text isn’t 

there, but it’s only there to sup-

port the picture.

Icons are easier to keep  
in mind
These pictures also make it 

easier to remember things. 

Visuals make connections in 

the brain that are stronger and 

easier to get to. 

If we called this design “ a 

little parallelogram attached to 

the top of the main rectangle, a rectangle with a circle in the middle, and a 

rectangle with a circle in the top right corner, all in a landscape orientation,” 

it would take you a few seconds to figure out what we’re talking about.

But if we showed you an icon like this one, which looks like a camera, 

you’d know right away what it is, right?

These are examples of affordances from a design point of View. This 

design principle is based on what has already been done. People know what 

to expect from your design, which makes it easier for them to recognize 

and understand.

If something looks like a button, people will probably push it. Most 

people think an arrow pointing to the left means “go back.” ...et cetera. Many 

of these affordances are used by icons to help people understand designs.

Icons make things look better and are easier to use
Next, using icons on your website makes your pages and content look better 

and more accessible.

From an aesthetic point of view, they break up long blocks of text with 

contrast, which is one of the most important design principles. They can 

stop pages from having too much text. And by using color, they can make 

page designs that are more interesting and easy to remember.

They give an excellent visual representation of what’s on the page and 

what it does. We know that a magnifying glass has something to do with 

looking for something or doing research. When we look at a product page 

and see a shopping basket, we know that it means “buy now.”
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You can also break up long text sections with icons to give the reader’s 

eyes something unique. It makes the pages easier to read. This helps with 

how your website pages are laid out as a whole.

As part of your brand identity, you can use icons as tools
Lastly, from the point of view of brand strategy, you can use icons to make 

your brand identity more robust.

You can change the icons’ color, style, and “tone” to make them fit in 

with your brand. When you use these elements in the same way over 

and over again, it helps build mental connections and strengthens those 

design elements.

For example, look at all the icons in the picture at the top of the page. 

Repetition is another critical design principle that you can see we’ve used 

to make our colors and style stand out.

So, with these benefits in mind—that ideas can be shown visually to 

make them easier to understand and remember, that visual appeal and 

usability can be improved, and that your brand identity can be built—move 

let’s on to the case study.

Learning with a project
This project that we will use to explain the process of icon making is aimed 
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to make a set of branded icons to replace the default icons we used on the 

first version of the Three-Brains.com website.

When the site was first setup, the creators used a page template called 

Neve and tools from Elementor to build the site. With these tools, you could 

add an icon box, which gave you access to Font Awesome’s library of more 

than 1,500 free icons.

That’s a good tool and shortcut for new sites to add icons to their pages 

quickly. You can change the size, color, and placement of the icon on the 

website to make it stand out more.

Even though that wasn’t a problem in the short term, we wanted to 

show you, if you are working on a long term project, how you can fix it in 

the long run. Because it meant that the icons weren’t made especially for 

that site, they could be copied by any other website that used the same 

templates and tools.

Step 1: First, make a New Document in your icon size.Set the Units to 

Pixels, the Color Mode to RGB, and the Raster Effects to 72ppi.

Step 2: We’ll now set the GridGrid to pixels, making it easier to plan 

the design. Go to Preferences > Guides and Grids and set the Gridline 

to 10px with ten subdivisions. Then go to View> Show Grid and View > 

Snap to Grid.

Step 3: I like to start with a quick thumbnail sketch for all of my icons, 

except for the simplest ones. You can draft with paper and pen or draw in 

Photoshop or Illustrator. I made my sketch in Photoshop and then copied 

and pasted it onto the artboard in Illustrator.
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Once the sketch is on the artboard, I can resize it, move it, and lower its 

transparency to 50%. If you’re using a graphic, lower the opacity to 50% (or 

more if the sketch is too dark), lock the layer, and make a new layer under 

the sketch layer. This will be your artwork layer.

Step 4: You can break up any complicated shape into simple shapes. We 

used the Ellipse Tool (L) to trace the head for this design. We then used the 

Selection Tool to move and rotate the shapes (V).

When the basic shapes are roughly where you want them, use the Shape 

Builder Tool (Shift+M) to combine them by dragging the cursor over them.

Step 5: Use the Pen Tool (P) to draw the basic shape if you need to make 

small curves. Make a point in the middle of each turn. This is where the 

lines will be smoothed.

Hold down the Shift key to make curves from points and drag the end 

with the Convert Anchor Point Tool (Shift+C). Use the Reflect Tool to make 

symmetry more simple (O). To reflect a shape, select it with the Selection 

Tool (V), then choose the Reflect Tool (O) and Option + Shift + O. Click where 

the body will be reflected on the artboard. You should now see a settings 

box. Set the axis to how you want the shape to be mirrored (my image is 

reproduced vertically), then click Copy. You now have a copy of your body 

that is flipped. Use the Shape Builder Tool (Shift+M) to combine the shapes 

and the Convert Anchor Point Tool (Shift+C) to smooth out any rough edges.

Step 6: Now comes the good part. There’s a way to see your icon’s appear-

ance while making it. Go to Window> New Window to start. This creates a 

copy of the document you’re currently working on.

Hide the Grid once you’ve made the new Window. Set the Window to 

Concrete Size, hide the artboards, and choose Pixel Preview from the “View” 

menu. You will now have a pretty good idea of how your finished icon will 

look. The best part about working with the second Window is that anything 

you change in the first Window will also change in the double Window.

Step 7: Use the Round Rectangle Tool and Option+Click on the artboard 

to make a button behind the icon. Then a settings menu will come up. Set the 

Width and Height to a few pixels less than the final size of your hero. This 

will give you room to add drop shadows or other effects later. Depending 

on the size of your icon, you’ll need to choose a different corner radius. 

Once you’ve made the rounded rectangle, to hide it, use Command + Left 

Square Bracket Key and drag it behind the symbol.

Step 8: Fill the rounded rectangle with the Gradient Tool (G), then set 

the bottom swatch of the rise to a mid-gray and the top swatch to a very 
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light grey. Finally, click on the gradient just under the complete swatch to 

add the third swatch. A darker shade of the second grey should be used 

for the third swatch.

To add an outline, go to the Appearance Panel (Window > Appearance) 

and select the rounded rectangle. Then, click on the stroke option, set the 

color to a mid-gray, and put the weight to 1px.

Step 9: Now, we’ll give the shape of the icon a gradient outline and save 

the styles of the button and the icon for future designs. First, making an 

offset path is the easiest way to add a gradient outline to a shape. To do this, 

select the form and add a new fill on top of the first in the Appearance Panel 

(Window > Appearance). Make this gradient a little darker than the first one.

Choose the maximum gradient in the Appearance Panel and click the Fx 

button at the bottom of the panel. After selecting Path > Offset Path, make 

sure the Offset is set to -1px with Round Joins, and then click the OK button.

Go to the Appearance Panel and drag the icon at the top of the panel 

into the Graphic Styles Panel (Window > Graphic Styles). This will save 

the look as a swatch.

Icons are all around us now. Now you’re ready to make a whole set, 

whether it’s for a business, a holiday, or something else. 
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Information 
through graphics

U
sing Adobe Illustrator, a lot of work is made really simple. 

Dealing with infographics is one such issue. With this platform, 

you have access to the best tools for creating design components 

for stunning infographics that combine creative design, sophis-

ticated data, and narrative storytelling. You will discover what infographics 

are, how to utilise them, and how to make them using Adobe Illustrator in 

this chapter.

What are infographics?
An infographic (also known as an information graphic) is “a visual represen-

Make pictures with information and 
say a thousand words with a picture
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tation of information or data,” according to the Oxford English Dictionary. 

But an infographic has a far more narrowly defined definition. The term 

infographic refers to a visual representation that combines images, data 

visualisations, and some text to summarize a subject clearly.

Infographics make information plain and concise by using eye-catching, 

captivating pictures. Infographics are an effective visual communication 

tool. We tend to pay the most attention to infographics that are visually 

striking, imaginative, and engaging. But it’s important to keep in mind that 

an infographic’s images need to accomplish more than just intrigue and 

captivate the viewer. They must assist us in comprehending and remem-

bering the information presented in the infographic.

What are the beneficial needs for infographics?
Infographics are excellent at simplifying difficult concepts. They can be 

useful whenever you need them. The following mentioned points show 

the places where infographics can be used: 

1. 	 Give a brief introduction to a topic.

Two types of inforgraphics
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2. 	 Describe a difficult procedure.

3. 	 Display study or survey results

4. 	 summarise a lengthy report or blog post

5. 	 Compare and contrast many choices.

6. 	 Increase public awareness of a problem or cause.

What are the key factors that you should keep in mind before 
designing an infographic?

The story behind your idea
An infographic’s goal is to communicate a narrative. An infographic is 

merely a graphic without a narrative. Think about it:

What sort of tale do I want to tell? Is it pertinent to my company? Why 

am I sharing this narrative? To whom am I conveying this tale?

Data
Accurate data is the most crucial part of an infographic. In high school, you 

were required to produce a report and cite all of your references, and they 

all had to be reliable. An infographic resembles a high school report. Using 

reliable sources can help you verify that your data is correct. You merely 

need to find and organise the data you already have as an organisation. Make 
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sure the infographic credits the source of the data, wherever that may be. 

Information that is uncredited is not only immoral, but most readers don’t 

trust it. Remember that the facts must convey a narrative.

Copy
After you’ve finished with the facts, you should concentrate on crafting 

content for your infographic. To put the facts into perspective and connect 

the whole tale, you will need bits of copy. Make a compelling headline. 

With all that information, an infographic may become rather lengthy and 

complex, and grabbing readers’ attention starts with the headline. Keep it 

succinct yet detailed because it will be used in tweets, posts, and pins. Avoid 

trying to be sophisticated; keep things straightforward. Put your attention 

on telling your narrative to the audience.

Design
An infographic’s layout needs to be determined by the narrative. If your 

infographic is about nature, for instance, it should include natural colours 

and design components. Only use a maximum of three colours in your 

colour scheme. A confused infographic may be caused by employing too 

many colours. Use legible typefaces. Make sure a typeface is readable in both 

large and tiny text before choosing it, especially when employing numerals. 

Pick no more than two fonts. 

Allow for headings of varying 

sizes to divide the data. Use 

visual organisation to lead 

your viewers through the 

information. Once more, keep 

it simple and don’t allow the 

story and facts to get lost in 

the design. A balance between 

data, copy, and design is 

essential for good design.

Charts and graphs
An infographic does not use 

the standard Excel bar graphs 

and pie charts. The designer 

will shine in these graphs and 
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charts since they provide the facts in a distinctive and imaginative manner. 

The data and the narrative will determine the sort of graph or chart that 

is utilised. Consider, for instance, putting human silhouettes in a chart 

while displaying statistics about individuals. When applicable, substitute 

graphical components for numbers. Don’t overdo the graphs and charts 

in your infographic. You need a good combination of graphs, charts, and 

design to communicate your tale.

What are the different types of infographics that you can create 
using Adobe Illustrator?
1. 	 Informational infographics:- They are the perfect option if you want to 

provide a brief summary of a certain subject.

2. 	 Statistical infographics:- These infographics are ideal for visualising 

survey findings, providing numerical evidence to support a claim, or 

presenting data from many sources.

3. 	 Timeline infographics:-  Using a timeline infographic, you can quickly 

emphasise significant dates or provide a summary of events.

4. 	 Process infographic:-  If you want to summarise or provide an overview 

of the stages necessary to finish a process, a process infographic is an 

ideal option.

5. 	 Geographic infographics:- The geographic infographic is your best 

option if you want to depict location-based or demographic data.

6. 	 Infographics that are organised in a hierarchy present information from 

greatest to worst, or from top to bottom.

7. 	 Comparison infographics:- The comparison infographic may be used 

to demonstrate how one choice is superior to another or to compare a 

set of possibilities in an objective manner.

8. 	 List infographics:- Use one of these to offer a list of practical advice, 

references, illustrations, or anything else along those lines.

9. 	 Infographics for resumes:- This infographic style is ideal for creating a 

résumé, as the name implies. Including a resume infographic in your 

CV is the best course of action if you’re looking for a new job and want 

to stand out from the competition.

Tips to keep in mind before starting your infographic design
1. 	 Make a huge, bold statement about anything you believe to be significant.

2. 	 Smaller font sizes than those used for the main headings and subheadings 

might be used for the supporting remarks.
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3. 	 Enlarge every single numerical figure you are displaying and treat it as 

important data.

4. 	 Remember to reference your sources at the conclusion. Use a tiny 

font size or italics.

5. 	 Give the information a unified presentation. If one component is 

aligned to the left, the other components should do the same. If not, 

re-align your layout in a single alignment. Nothing should appear 

out of place.

6. 	 Remember that layout plays a crucial part, so make sure everything 

is aesthetically appealing.

7. 	 If you’re having trouble deciding on a layout, look for design 

ideas online.

8. 	 The greatest colour scheme to draw attention to your text is one that 

features black and white. This will highlight your text’s main ideas 

and get people’s attention.

9. 	 Don’t be scared to add some humour! When necessary, add patterns, 

texture, and gradient.

10. Avoid using lengthy sentences; instead, break them up into manage-

able, concise statements. Instead of a lot of words, infographics do 

best with short amounts of data.

11. 	Your very best friend is an icon! FlatIcons.com offers ready-made icons 

that you may use. If you don’t have enough time to make every single 

personalised icon. By doing this, you can focus on the important work 

at hand—creating the overall design of your infographic—instead of 

having to expend physical and mental resources.
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What is the method to design an infographic on Adobe 
Illustrator?

Step 1: Open Adobe Illustrator and create a new document
You must first launch Adobe Illustrator. then you must create a new docu-

ment with the infographic’s required dimensions. You may do this by 

selecting File > New or by holding down the Ctrl key while typing N. If 

your goal is to construct a portrait-sized infographic, you should start by 

giving your blank document a rectangular form. We will develop a template 

for this lesson that is 612 by 792 pixels and 72 PPI (pixels per inch). Other 

considerations include adopting screen resolutions of 72 PPI. Use 150 to 

300 dpi for print.

Step 2: Estimate the area needed for your infographic 
You should keep in mind that in order to create an effective information 

graphic, you must have a clear understanding of how much white space has 

to be allotted. This is referred to as the space allocation that you’re providing 

for each component that you provide. An infographic that is effective will 

contain even white spaces and enough data. Don’t try to finish everything 

at once. Make room for crucial information.

Setting the rulers to show visible will help you decide on the white space 

limit if you’re having problems. Now, all you have to do is press Ctrl+R (on 

Windows) or Cmd+R. (Mac). To make borders for your infographic, drag the 
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guidelines from the rulers. Work will be considerably easier over here if you 

choose inches. You can now clearly see coloured lines on your document. 

These serve as your spatial guidelines, giving you a sense of the spacing 

between the various infographic pieces.

Note: Try right-clicking the line and unchecking “Lock Guidelines” if you are 

trying to adjust the ruler guides but they are not moving.

Step 3: Compile and display your data
The data is a critical component of infographics, as I said in the main aspects. 

Collect accurate information, and then represent it visually. Research is 

essential for precise information once more. So, conduct extensive research. 

This will significantly improve the visual representation of your online 

portfolio. To recognise which data belongs to which project, keep a distinct 
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folder for each project. Keep in mind that infographics convey concise facts, 

thus you must ensure that your data is accurate and free from errors.

Step 4: Create the infographic’s components.
Yes, now is the moment to design your infographic. Your data and study 

must have been validated by this point. You should just think about how to 

enhance the presentation’s aesthetic appeal. Blocking out an infographic’s 

components is the easiest method to tackle it. You may design many graph 

kinds in Illustrator and alter them to your specifications. The Bar Graph 

tool, Radar Graph tool, Area Graph tool, and Scatter Graph tool are just  

a few of the built-in Graph tools in Illustrator. By directly inputting data  

into the Graph Data box, you may accurately represent that data in 

your graph.

Each piece of data is shown in blocks in our example, “The Rising Trend 

of Freelancing in 2018” (highlighted in yellow in the image above), and the 

blocks are sorted according to:

1. 	 Country

2. 	 Human Resources

3. 	 Age

4. 	 Gender

5. 	 Mobile Usage
Understanding the general idea of freelancing demand requires knowl-

edge of these data elements. You can now see how crucial the information 

presented here is. All pertinent information must be expanded, and sup-

porting information must come second.
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Step 5: Try different things.
Play with colours, sizes, and differences to make an information graphic 

effective. Make sure all of the data-derived portions appear really inter-

esting. As you can see from our sample, we included certain colours to 

accompany each data point while sticking with a modern palette with 

primarily warm accents.

How to make a simple infographic
Step 1: The Column Graph Tool is something you should look at if you 

want to keep things simple. You may either click J on your keyboard or 

choose that tool.

Once you’ve done that, you can simply click and drag to designate the 

area where your graph will appear. A window will then appear, allowing 
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you to choose the details of your graph. You can enter whatever number 

you like in this window. Simply click on apply after that.

Step 2: You may demonstrate how the numbers are changing by including 

another row. The leftmost row of numerals is the first row, and the rightmost 

row is the second row.

There is an option to import data from a few different document formats 

if you already have the information in another document and do not have 

the time to manually fill it out.

You can close the little window when you’ve completed entering your info.
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Step 3: It is a good idea to add colour to your graph to make it stand out. 

To independently choose each item of the graph, click Direct Selection Tool 

on the left side or just hit A on your keyboard.

Once you’ve finished, you may choose each element of your graph and 

give it a colour. Try not to mix up the colours, though, as you must do this 

for each row of your graph.

Step 4: Using the Direct Selection Tool, click on one piece while holding 

down Shift, then click on the second piece to pick both at once. If you 

wish to change the font, select the text you want to alter, then click the 
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Selection Tool or the V key on your keyboard, and then select a new font 

from Character.

Step 5: If your data has changed and you wish to modify your graph, 

you may do so by selecting the graph, performing a right-click, and then 

selecting the Data option. 

The previous window will reopen, and you may change the values 

there as necessary. You may edit the numbers and then hit Enter to view 

the change on your graph right away.

Step 6: You only need to input the text in your graph’s data if you wish 

to add text to it. But before inputting the numbers, you must enter the text.

Conclusion
There you have it. You now understand how to create an infographic utilising 

a template and infographic components as a base. With the help of these 

tools, you may design a straightforward infographic for social media or a 

scrollable work of art for a website. You will all discover a lot more interesting 

information in the upcoming chapters. Enjoy using Adobe Illustrator for 

designing infographics. 
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Saying it out 
loud!

F
or those who don’t know anything about graphic design, this 

chapter demonstrates how to use Adobe Illustrator to make a 

basic banner for your website. In today’s scenario, a banner 

is a need in many areas. Every digital business, even tradi-

tional businesses, demands it. Use Adobe Illustrator instead of Adobe 

Photoshop to generate a similar document since it results in fewer files 

and clearer graphics. The backdrop and text of your banner are its two 

components. In addition to text, we employ graphics and numerical 

callouts. We hope you have fun designing your banner. You’ll get to 

the specifics in this chapter, no doubt.

A good banner for every page, keeps 
people hooked to your webpage
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What is a banner?
In a nutshell, banner advertising is a form of digital marketing that uses 

visually appealing adverts called banners. In order to increase traffic to 

the advertiser’s own website, raise knowledge of it, and encourage general 

brand attention, banners are the creative advertisements that are shown 

along the top, side, or bottom of a website. This kind of online graphic banner 

advertising falls under the category of display advertising.

A banner ad is an effective approach to draw in more customers, pro-

mote a product, and/or get their attention. The CTR, or click-through 

rate, of an ad, is crucial 

to determining if banner 

advertising is effective. The 

click-through rate statistic 

is calculated by dividing 

the number of clicks an 

advertisement receives 

by the number of impres-

sions it received. Therefore, 

a banner ad’s effective-

ness may increase with 

increased CTR. To increase 

click-through rates, brands 

might examine the results 

of earlier campaigns or 

other data.

What are the main factors that make a banner stand out?
We’ve compiled a concise summary of the key components that make up 

an effective card design in the list below. Continue reading to discover 

what these design components are and how to apply them to the creation 

of your templates.

1. 	 Card Theme: The design theme should be taken into account before 

beginning to create any type of card. The basic goal of the card should 

be reflected in the card design theme. For instance, if you are designing 

a business card for your place of employment, you should produce or 

utilise a design template that radiates professionalism.

2. 	 Typography: The second component that needs to be included in any 

card template design is typography. This relates to the fonts utilised 
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in the card design as well as the formatting of these font types. These 

two elements ought to aid in constructing a story about the subject of 

your card.

3. 	 Color Scheme: You should also make sure that the card design you 

create uses an equally alluring colour scheme. The appropriate colour 

scheme can make your invitation or thank you cards stand out if you 

are making them. Or it could be wiser to use the firm’s official colours 

if you’re making membership cards or company ID cards.

4. 	Relevant Content: The content of a card should also be relevant. This 

is an essential element. This is a reference to the bits of data or specifics 

that may be seen in the card design. For instance, if you’re making a 

birthday card, it should include birthday wishes, but a membership 

card will include details about the cardholder and the organisation to 

which they belong.

5. 	 Printing Material Type and Size: When designing a card, it’s crucial 

to select the appropriate printing material type and size since they have 

an impact on the final product’s appearance and feel. For instance, if 

you are designing trade cards, you could decide to print them on thick 

cardboard, but business ID cards are ideally printed on plastic or PVC 

that has been laminated. You are more likely to produce a high-quality 

card design when these factors are taken into account while creating a 

card template.
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What are the major types of Banners?
Social Media Banners
One of the best methods to reach a larger audience and spread your message 

and ideas is through social media. These may be found on a variety of websites, 

including numerous gaming sites as well as LinkedIn, Facebook, and Twitter. 

One of the first things your viewers will see when they click on your profile 

on social media is your social media banner. It serves as a visual representa-

tion of you, your company, who you are, and the products and services you 

provide. A unified look across all social media platforms will make it easy for 

people to recognise you, promote interaction, and boost conversion.

Ad Banner 
Ad banners are a form of online advertising that is similar to social media 

banners in that they are shown on websites. The purpose of a website banner 

is to direct people to a particular website by connecting to it, and it can be an 

image- or multimedia-based. A banner’s primary purpose, whether it’s pro-

moting a new item or service, is to be clicked on. Website banners are typically 

utilised on high-traffic websites that share a theme with the advertisement.

Tips to design the best banner for your company
1. 	 Make use of the standard, most efficient banner sizes

2. 	 Put your banner adverts in the right spots. Purchase an online space 

where your artwork will be prominently displayed above the fold and 

next to the page’s primary content.

3. 	 Watch your hierarchy since effective banner ad design depends on the 

appropriate balance inside each ad. Effective banner advertising is made 

to raise brand recognition and improve website traffic. They consist of 

three fundamental parts:

4. 	 Keep your images and information minimal. Your web banner ad will 

probably only catch viewers’ eyes for a brief moment.

5. 	 Buttons, depending on the type of banner, frequently raise your ad’s 

click-through rate (CTR). Place them after your copy on the lower right 

side if you intend to utilise them (tastefully) contrast colouration.

6. 	 Possess a definite framework. People are compelled to look at a subject 

that is contained within a frame. Effective banner advertisements feature 

a well-defined frame with visuals that go all the way to the box’s edges.

7. 	 Ensure that your text is easily readable. Make the body copy and the 

headline various sizes. Four lines or fewer should be used for all copies.
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8. 	 When designing website banners, animated web banner advertisements 

are often more successful than static ones. However, you must be careful 

that they don’t detract from the advertising message.

9. 	 You’re more likely to gain the confidence of your visitors if your adver-

tisement visually fits in with the websites where it’s presented. Don’t 

let it, though, blend in completely. Always be able to see and click on 

banner adverts.

10. Keep your brand identity constant. Your banner ad will link people to a 

landing page with your offer on it. To avoid confusing potential buyers, 

make sure the ad and landing page is consistent with your identity.

How can you design an amazing banner ribbon using Adobe 
Illustrator?
Step 1: First, open a new document and use the Rectangle Tool (M) to draw 

a lengthy rectangle. Make the colour (R=241, G=96, B=124) for it.

Step 2: Use the Control-C and Control-B keys to drawing a second rec-

tangle to the rear. (R=221, G=47, B=97) Darken it.

Step 3: Turn on the Smart Guides by selecting View Smart > Guides, 

then place an anchor point in the centre of the rectangle’s left side. Move 

the anchor point to the right using the Direct Selection Tool (A).
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Step 4: Make copies of two designed forms that you’ve chosen (Control-C, 

Control-F). then select Intersect from the Pathfinder panel. The new form 

should be coloured R=196, G=14, and B=66.

Step 5: The trick is to choose two anchor points as illustrated in the 

figure below using the Direct Anchor Point Tool (A). Press Vertical Align 

Bottom in the Align panel.

Step 6: Pick the darkest form, then pick Arrange > Send Backward from 

the menu that appears.

Step 7: If the Smart Guides are still turned on (View > Smart Guides), 

that’s excellent. You’ll find it simpler to build a reflection.

Using the Shift key to pick two rectangles at once, choose the darker 

(R=221, G=47, B=97) and the darkest (R=196, G=14, B=66) rectangles, and 

then click the right mouse button. Then, in the newly appearing box, choose 

Transform > Reflect and Vertical axis of reflection, and hit Copy. shift the new 

copies in the right direction. Here, you have your amazing banner ribbon.

How can you change the colour of any art design in Adobe 
Illustrator?
1. 	 Pick a piece of art to recolour.
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2. 	 To access the Recolor Artwork dialogue box, click the Recolor button 

in the Properties panel on the right. On a colour wheel, hues from the 

chosen piece of art are shown.

3. 	 To alter all of them, drag only one colour handle on the colour wheel. 

To unlink the colours and alter them separately, click the Link Unlink 

Harmony Colors button.

4. 	 To recolour artwork, select colour groups, document swatches, or preset 

colour schemes from the Color Library menu.

5. 	 To sample and apply the colour, click the Color Theme Picker button, 

then click both vector and raster items on the canvas. To sample certain 

colours, drag a selection through a piece of vector art.

6. 	 Drag the lever between colours to change the weight of colour in your 

artwork in the Prominent Colors area of the Recolor dialogue box.

7. 	 Click the folder icon at the bottom of the dialogue box to store every 

colour in the Swatches panel. To just store the colours displayed in 

the Prominent Colors section, select Save Prominent Colors or Save 

All Colors.

How to create colour swatches for your banners?
1. 	 By clicking the fill colour or stroke colour in the Properties panel to the 

right of the document and choosing the Swatches option to expose the 

swatches in the document, you may save custom colours as swatches.

2. 	 At the bottom of the new panel, click the New Swatch button.

3. 	 Choose a colour and its choices. To save the colour as a swatch, click OK.

4. 	 By choosing artwork, clicking the fill or stroke colour in the Properties 

panel, choosing the Swatches option, and choosing the new swatch, you 

may apply it.

How can you insert text in your banner?
1. 	 Click the Type Tool in the Toolbox or use the T key on your keyboard.

2. 	 Select any location inside your banner.

3. 	 Type the text you want to use.

4. 	 To quit typing mode on your keyboard, use the Esc key.

Click your banner’s backdrop only if you can’t read the text. In the Fills 

(RGB) box, click any square to make your text visible.

Changing the font-size
First, click the text. Click the right mouse button after that. Place the mouse 
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pointer over Size and select the desired size. Repeat these steps and try a 

different font size if your text is too tiny or large.

Changing the font style
Press the text. Right-click the mouse button. Click the desired font name 

by placing the mouse pointer over Font. Repeat this step and try a new font 

name if you don’t like the existing font. To leave, click anywhere outside 

the banner.

Center aligning your text
Click your text and the backdrop of your banner while depressing the Shift 

key on your keyboard. choose Window from the menu. Align, click. A new 

window would emerge, as you’d expect. Select the button for Horizontal 

Align Center. To vertically align, choose the button. To leave, click anywhere 

outside the banner.

Change the colour
Toggle your text. Menu Window, click. Swatch Libraries should be the focus 

of your mouse. Toggle to Default RGB. In the Default RGB box, click any 

square to alter the colour of your text.

Conclusion
You have it now! These are but a few recommendations for banner design. 

But genuinely outstanding, high-converting advertisements require much 

more. If you were not a skilled designer then you hopefully are now. If not 

an expert, you atleast know your way around making basic banners. So 

tinker around and make yourself even more proficient at making banners 

using Illustrator. 
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Uncharted

A
mong other things, Adobe Illustrator is frequently used to 

create graphs for different applications. The graph tool in 

Illustrator may also be used to produce colourful graphs and 

charts. When developing company brochures, print advertise-

ments, reports, and presentations are incredibly helpful. One of the most 

important graphic formats for representing information in a thorough 

manner is a chart. Therefore, we will explore how to use the graph tool in 

Adobe Illustrator in this chapter.

What are a chart and its importance?
A chart uses text, symbols, and/or visuals to illustrate how several data 

sets relate to one another. They are a widely used technique for informa-

Of the pies, bars, doughnuts, and 
everything else
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tion exchange in various contexts. For instance, a bar chart may display 

the evolution of ice cream sales of a specific flavour over the last five years. 

Each bar’s length would represent that year’s revenues.

Key factors to keep in mind are as follows:
1. 	 Multiple pieces of data may be graphically compared using charts.

2. 	 The use of charts makes it easier for people to absorb and recall infor-

mation. Many individuals comprehend images more rapidly than long 

passages of text.

3. 	 You may strengthen your argument and give your presentation more 

credibility by using a compelling chart.

Applications are expanding daily and need some of the most sophis-

ticated components for data visualisation and analysis. In desktop pro-

grammes like Microsoft Excel or OpenOffice.org Calc, graph production is a 

regular function, but it can 

also be done in non-spread-

sheet software like Adobe 

Illustrator. To illustrate 

data, Adobe Illustrator 

provides 9 different types 

of graphs. Column, bar, 

stacked column, stacked 

bar, area, line, pie, scatter, 

and radar are the graph 

types you may select from.

Which tool is used to 
create the charts and graphs in Adobe Illustrator?
We use the graph tool. The graph tools are located in the toolbar on the left 

side of the document window in Adobe Illustrator. Column Graph Tool is 

the default graph tool, however, you may extend the menu by clicking on the 

icon to see more graph tools. You’re utilising the basic toolbar if you can’t 

find the tools on your toolbar. A toolbar with an advanced function must be 

created by going to Window > Toolbars > Advanced from the overhead menu.

How to Use Adobe Illustrator’s, Graph Tool?
In Adobe Illustrator, there are nine pre-made graph tools, and the process 

is the same. Regardless of the tool you select, you will be required to enter 
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data into the sheet, and it will produce the type of graph you want. Let’s 

look at a few illustrations for making graphs on the Illustrator platform.

Creating a bar graph using the graph tool
Bar graphs are extremely similar to column graphs, with the exception that 

the data is presented in a different way. Let’s go through the procedures to 

construct your own bar graphs now:

Step 1: To begin, select the Column Graph Tool from the toolbar or 

activate it using the keyboard shortcut J.

Step 2: To scale the 

graph after activating the 

Column Graph tool, click 

on the artboard and then 

enter the desired value. 

Alternatively, you can just 

click and drag on the art-

board. If you don’t have a 

precise size in mind, don’t 

fret; you can always adjust 

the graph.

After you click the OK 

button, let’s go on. You’ll see a sheet appear for you. The data for the graph 

must be entered there.

Step 3: Now, you need to enter the data. Enter the characters in the 

white bar above the first box you click on in the table. The characteristic 

will appear on the table after you press the Return or Enter key. You may 

enter Data A, Data B, Data C, and Data D as an example.

Then enter the value for each attribute in the table’s second row. For 

instance, you may put the numbers 20, 50, 25, and 5 under the corresponding 
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data if Date A is 20%, Data 

B is 50%, Data C is 25%, 

and Data D is 5%.

Reminder: The sum of 

the numerals must be 100.

Now you may import 

and edit graphs from 

Excel with the aid of Adobe 

Illustrator. Therefore, to 

transfer your data from 

Excel to Adobe Illustrator, click the Import Data option and choose your 

Excel file if you already have the data in Excel and don’t want to duplicate it.

After entering the data, click the check button to finish and save the 

sheet. The graph will appear in grayscale.

Step 4: To ungroup the graph so you may change it, select it and choose 

Object > Ungroup from the menu. You’ll receive a message when you 

ungroup. Select Yes. Because the text and the forms are typically clustered 

together in subgroups, you’ll need to ungroup a few times.
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The graph may be styled after the items have been ungrouped. If you 

like, you may alter the colours, add texture, and text, or even create a 3D 

column graph. Taking colours as a starting point.

Step 5: Choose the columns and modify their colours. In Adobe Illus-

trator, filling in colours may be done in several ways. If you don’t find the 

wanted pick, make your own swatch.

Making a PIE chart using 
the graph tool
Step 1: If you’re using the 

Advanced toolbar, you can 

locate the Pie Graph Tool 

on the same menu as other 

graph tools. From the over-

head menu Window select 

the option Toolbars. Then 

click on Advanced, you 

may rapidly change from 

the basic toolbar to the 

advanced toolbar if you’re 

using the basic toolbar.

Step 2: Make a pie chart 

as a first step. Click on the 

artboard after selecting the 

Pie Graph Tool from the 

toolbar. You must enter the 

chart’s size in a window that 
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appears when you click on the graph. Click OK after entering the width 

and height settings.

Now, you will see a table and a circle(chart basic template).

Step 3: At this point, you must enter the attributes. Enter the characters in 

the white bar above the first box you click on in the table. The characteristic 

will appear on the table after you press the Return or Enter key.

As an illustration, you may enter Data A, Data B, and Data C. Then 

enter the value for each attribute in the table’s second row. For instance, 

you may put the numbers 20, 50, and 30 under the corresponding data if 

Date A is 20%, Data B is 50%, and Data C is 30%. The sum of the numerals 

must be 100.
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You should get a pie chart sim-

ilar to this one after clicking the 

Check icon.

Step 4: Close the graph table.

Step 5: The pie chart has to be 

styled and edited at this point. The 

pie chart’s colour and wording can 

be altered. To give the pie chart a 

more contemporary appearance, 

remove the stroke colour. Click the 

black rectangle adjacent to Data 

A and the black colour on the 

pie chart using the Direct Selec-

tion tool. To fill the colour, select a 

colour from the Swatches panel or 

use any other techniques.

Change the colour of data B and 

C using the same procedure.

Additionally, you may change 

the data’s wording or manually 

add text to the pie chart.

Now, you have your PIE chart 

ready with you.

Creating a Line graph
To see the nested tools, click and 

hold the Column Graph Tool in the 

Tool Bar. A line graph tool should 

then be chosen. 

Wherever you want the graph 

to appear, draw a rectangle. Auto-

matically, the Graph Data Panel 

will appear.

Enter it manually into each 

cell in the panel by using Tab to 

advance to the following cell in a 

row, Enter to advance to the fol-

lowing cell in the same column, or 



67Uncharted    Uncharted

the arrow keys to move between cells. Click the Import Data button in the 

Data Panel and choose the text file from the directory to import data from.

To see the data appear in the graph, click Apply. Because I’m utilising 

data on the average price each year, where the years would be the labels, 

nothing occurs in this case. All numbers are automatically regarded 

as data.



68   Uncharted

The years need to be contained in quotation marks in order to become 

labels. Click a year-containing cell in the Data Panel, then navigate to the 

Text Entry Box and enter straight quotes (“) at the start and end of the text.

Dollar signs must be removed from each cell in the Data Panel as they 

are not recognised when numbers are structured as currency. Click Apply 

once the formatting is appropriate. 

In the Data Panel, click the Close button. Click Save when asked to save 

the changes.

Objects are arranged in graphs. For formatting, make use of the Selection 

Tool and Group Selection Tool. Use the Selection Tool, right-click on any 

area of the graph, and choose Type to access other graph choices.

In the dialogue box that appears, select Value Axis from the Graph 

Options menu.

Set the Prefix to $ and change the Tick Marks Length to Full Width. 

Type 0 in the Suffix field. Select OK. 

You may make 

artwork to replace 

the graph’s square 

markers. One of the 

markers can be copied 

and pasted using the 

Group Selection Tool. 

Place the pasted marker 

behind the artwork as 

the item is furthest to 

the rear. The artwork 



69Uncharted    Uncharted

may exceed the marker in size. 

Go to Object > Graph > Design 

after selecting the design.

Click New Design in the 

dialogue window.

To give the design a name, 

click Rename. To close both dia-

logue windows, click OK.

Markers on the graph should 

all be selected, including the one 

in the legend. Go to

Select Marker from Object > 

Graph. Click OK after selecting 

the marker. Using the Group 

Selection Tool, finish format-

ting the graph’s components. 

You may easily move anything 

to the pasteboard that you don’t 

want to display on the graph, 

such as the legend.

Adding pictures and 
symbols to your graphs
Images can be added to columns 

and markers in graph designs. 
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Graph designs can be straightforward sketches, logos, or other symbols that 

represent values in a graph, or they can be intricate things with patterns 

and guiding elements. There are many pre-made graph designs available 

in Illustrator. Additionally, the Graph Design dialogue box allows you to 

build fresh graph designs and save them there.

When stretching or compressing is done vertically, a vertically scaled 

design is typically employed. In this case, the width remains constant.

When scaling is done both in the vertical and horizontal directions, a 

uniformly scaled design is employed. The designs’ horizontal spacing is 

not altered to account for the various widths.

Repeating Design: To completely fill the columns, this design is layered. 

Here, you will need to specify the value that each design is representing as 
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well as if you want to scale or slice fractional design elements.

A sliding design is comparable to a vertically scaled design, but you may 

define where to extend or compress the design. For instance, if a human 

were being used to represent data, you may merely expand or compress 

the body and leave the head alone. The entire person would be scaled if the 

Vertically Scaled option was selected.

Now, to import the designs follow the steps below:

1. 	 Choose the option Swatch Libraries > Other Library under Window.

2. 	 Select the source document, then click Open to import graph designs from 

it. At first, only a new panel with the colours, gradients, and patterns from 

the imported file is visible. When you open the Graph Column or Graph 

Marker dialogue box, the imported graph designs will be accessible.

Conclusion
Using the Graph Tool in Adobe Illustrator, you can quickly create a bar 

graph, a line graph, or even just a pie chart, and you can alter the chart 

using a variety of style choices. To create a stunning pie chart, keep in mind 

that the numbers you add in the Graph table must sum to 100. Make sure 

the text and numbers are highlighted whenever you choose the colours. 
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Paper the 
digital wall

N
owadays, technology is there all the time and everywhere. 

Being without a smartphone is practically unheard of nowa-

days. Screensavers, backgrounds, and the ability to personalise 

them are all part of the smartphone experience, but it can be 

challenging to locate one that perfectly matches your needs. This chapter 

will show you how to construct a fantastic text-based wallpaper that you 

can personalise. You may use the wallpaper for your desktop and wow 

your friends at the same time. Why not design a landscape-themed vector 

wallpaper? You will learn how to make an attractive wallpaper fast and 

easily by following the steps in this chapter. Let’s start now!

Why download wallpapers from the 
internet when you can make your own
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What is digital wallpaper?
For many years, people have depended on wallpaper to give a room a little 

colour, texture, and personality. Digital wallpapers may now be created 

because of recent breakthroughs in printing technology and technology. 

Among its many advantages, digital print wallpaper can breathe life into 

bare walls. What they can provide businesses is as follows. A sort of big-

scale printing called digital print wallpaper can assist businesses in the 

following ways:

1. 	 It truly steals the show.

2. 	 It might always seem brand-new. If you want it to, since it’s so distinctive 

and memorable, it may increase brand recognition.

3. 	 It’s Sturdy and Lasts a Long Time

Since it doesn’t require stock, digital wallpaper is also intriguing from 

a business perspective. Digital printing is perfect for small runs since it 

allows you to print only as much as is required for a particular order or 

project and still turn a profit. Some designers are even fusing analogue and 

digital by using outdated material and digitally printing fresh, fashionable 

designs on top of it. No longer must wallpaper designers repeat patterns 

every certain number of inches. It’s exhilarating, to say the least since it 

opens up all kinds of possibilities. Additionally, colour gradients without 

distinct lines are now also feasible. Using Adobe Illustrator, you are in 

control of creating the desktop wallpaper of your choosing.

How can you create your phone wallpaper with Adobe 
Illustrator?
Step 1: You must thoroughly examine your first thought and ideas and come 

up with a basic design that meets your needs before you begin designing 

the wallpaper for your phone. For instance, you choose “Dragons” as your 

theme after drawing inspiration from the school mascot. Depending on 

what you want and how much work you want to put into it, it may be a 

single word or a whole phrase. You may pursue whatever goal you have. 

This chapter will demonstrate how to use Dragon’s themes to make it really 

simple and clear for you all.

Step 2: Okay, you are now prepared with that thought in mind. Therefore, 

you must launch Adobe Illustrator and begin the identification process. 

To begin a new project in Illustrator, click “create new” on the left side of 

the window. Then, choose “mobile” in the pop-up window and browse the 

possibilities until you find the one that is appropriate for your phone. Now 
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select the screen resolution that meets your screen size requirements. m 

Now, for the orientation, we advise choosing the portrait option (which is 

taller than it is broad) and then choosing to Create.

Step 3: Now that your board is opened, you can quickly put your design 

ideas into action. Select the text tool (it looks like a letter “T” in the toolbar 

on the left). After that, you will need to click on your artboard, move it, and 

then write your chosen word or phrase into the textbox you just created. 

When you’re finished, you can giggle. By holding down the command key 

and clicking away from the text, you may alter the font of your text. After 

you enter your text, switch immediately to the very helpful selection tool.

A rounded sans serif is ideal for the example that we are building in 

this tutorial. Use the font “CarlMarx Bold” now.  Houschka Rounded, Arial 

Rounded MT Bold, and Clone Rounded Latin are more possibilities that 



75Paper the digital wall    Paper the digital wall

can be found on Adobe Fonts; pick the one that best suits your preferred 

style. Now that you’ve finished writing the content, you’ll need to outline it. 

There are three ways to achieve this. The option to make outlines is avail-

able by right-clicking your text (or two-finger touching if you are using a 

MacBook), clicking the type tab at the top of your screen, or clicking the 

shortcut hold shift, command, and “o.”

Step 4: Choose the freshly outlined text, then go to the top left and change 

the fill to white and the outline to black. You may also use the shortcut key 

“d” to make these changes. Finally, adjust the stroke weight to 2 points.

Step 5: You must now choose that part of the text once more. Select the 

object tab by moving your cursor to the top of the screen. After that, you 

must choose to create with mesh from the pop-out menu under envelope 

distort or use the keyboard shortcut Option (alt), Control, “M.” After you 

finish, you must do this in order for the envelope mesh menu to appear. The 

number of columns and rows will be the default number when you check 
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the preview box in the lower left; you may change it based on the length 

of your text. In this example, we’re expanding the number of columns to 

6 while retaining the number of rows at 4. After that, click OK to apply 

those modifications. The anchor points in some of your columns need to 

be selected first. To select multiple points, hold down the shift key. Then, 

you may use the arrow keys to move the selected points up or down. We’ll 

start by moving every other column up 10 points using the arrow key. The 

rows must then be adjusted in the same way; we’ll choose to move them 5 

points to the right. The outcomes are displayed in the image.

Step 6: Select your text using the selection tool(V), duplicate it, go to 

the object tab at the top of the screen, scroll down, and click expand. Before 

selecting “ok,” double-check that “objected” and “fill” are both chosen on the 

expand menu. Select the enlarged text with the selection tool, hold down the 

option (alt) key while dragging a duplicate down, and then simply change 

the text once again by using the shortcut “ctrl” and “d.” Then, after selecting 

all three bits of text, choose the object tab from the top menu, and blend. 

Select your text, and then click “blend options” to bring up a window. Once 

this has opened, click the preview button to make sure it looks OK. Then, 

go to spacing and choose the number of steps you want—we’ve chosen 

fifteen—and make sure the vertical option is chosen for orientation before 

clicking the “OK” button. This step’s results are displayed in the picture. 

create from the pop-up menu, or use the shortcut option control-”b”. Choose 

your text once more.

Step 7: The ellipse tool, which resembles an oval, is the next thing you 

should choose from the toolbar. If it is not immediately visible, you will 

need to right-click either the rectangle tool or the star, line, or polygon tool 

instead. It is typically the item that is fourth from the top of the toolbar. 
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Construct a circle on your artboard next, switch to the direct selection tool, 

pick the top and right anchor points, and then erase them. Then, using the 

top anchor point as your point of reference, click and drag it to the side to 

create an S curve. 

Return to the section tool (V) and pick the curve as well as your text. 

This time, instead of selecting blend in the object tab’s blend section, we 

want to choose to replace the spine. Feel free to design the route as you 

wish because doing so will cause your line of text to follow the curvature 

of your path. Return to the option blend menu and choose reverse spine 

if you’d rather your text appear at the bottom rather than the top. In the 
illustration, reversed spine is designated as number 2. Then, select the 

trim function, which is usually the second one in from the left under 

pathfinders (the icon is of a full square on top of another, or if you hover 

your cursor over them, a label should pop up), which will make your text 

more precise. After doing this, go to the right side of your window and 

select the pathfinder tool, which looks like two overlapping squares (if 

you can’t find it there, you can also find it under the windows tab in the 

top navigation bar).

Step 8: Although not required, this phase is enjoyable, may produce some 

fascinating effects, and further personalises the piece for you. Go back to 

the original set of text you were working with (not the one you extended in 

step 6) and select it. Then, go to the top bar and choose the isolation button, 

which is represented by four arrows pointing towards a box. 

When you choose the top text layer and remove the stroke and fill colours 

from it, a gradient will be created that will repeat with the other two text 

layers as well. To do this, go to the layers panel on the bottom right of your 

screen and click the arrow to reveal all the items on that layer.
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If you want to take it a step further, you can use the morph option of 

the direct selection tool (a) to rotate and shift each letter while also moving 

them about to add even more interest and originality.

Step 9: When you’re done and satisfied with your creation, you’ll need to 

download the image to your phone so that you may set it as your wallpaper. 

To accomplish this, click the file tab at the top of the screen, scroll down to 

export, and then click export for screens. In the pop-up box that appears, 

select the destination folder for the export, then click Export Artboard. From 

there, you may send it to yourself through email or, if you have an iPhone 

and a Mac, you can airdrop it.

Tips to design an artistic wallpaper
1. 	 Keep it straightforward but significant. Wallpaper design components 

should be kept to a minimum because too many might possibly damage 

the experience. Try to keep your wallpaper design simple and only 

include the aspects that are important to you. The aesthetic attractive-

ness of the design is also maintained by using straightforward, simple, 

and sharp wallpaper designs.

2. 	 Keep the typeface creative. The design of letters known as a font can 

come in a variety of styles, including extra bold, bold, regular, light, italic, 

condensed, extended, etc. When designing wallpaper, use a typeface that 

won’t draw attention away from the design features. Ensure that every 

text is readable. You must adhere to the best typographic conventions, 

such as using contrasting fonts like Anton and Julians Sans for quota-

tions and sans serif typefaces for headers.

3. 	 Pick a colour scheme that coordinates. Your colour scheme should 

complement the design you have in mind and not conflict with any 

of the wallpaper design’s aspects (both foreground and background). 

Whichever colour combination you choose, what counts is how well they 

work together. Here’s a tip you may use: when creating your palettes, 

use the Color Wheel to select the ideal pairings.

4. 	 Image optimization according to screen size You must size-optimize 

each picture you choose for the wallpaper design’s foreground and 

background. When using them as wallpaper, make sure they are the 

exact size of your screen and are not pixelated. Image resizing improves 

quality over here.

5. 	 Play around with animation. Yes! A few components in your wallpaper 

design, such as corners and small icons, can be animated. To give your 
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wallpaper design a competitive edge, make sure to employ minimum 

motion and avoid going overboard. Keep in mind that any motion you 

incorporate into your design must not obstruct the view of any folders 

or documents that are shown in the foreground.

Conclusion
Discover your inspiration. While some people choose to have their favourite 

superheroes as wallpaper backgrounds, others think family portraits make 

good wallpaper designs. Therefore, do some research and identify the aes-

thetics, tone, and spirit you want in your design before you begin creating 

your wallpaper. Give the wallpaper design a little touch of your personality. 

You merely employ the tools you require to designate the ideal wall painter 

for you. Not to worry! Over time, you will become more adept. 
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Level it up

I
f you enjoy designing, you probably already know about the idea of tem-

plates. You may find some of the best templates for your creative works 

with the aid of Adobe Illustrator. You can find simple designs for some of 

the most well-known 

ones. You can use templates 

to create some really great 

designs. The ones that leave 

a lasting impression. 

What are template 
layers?
Template layers allow you 

to manually trace pictures 

You’ve learnt all the basics. But, some 
things still remain
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since they are locked, nonprinting layers. Using template layers can be 

quite helpful when tracing raster pictures or making artwork from scans 

of mockup designs. To make it simple to notice any pathways you draw 

over a layer, template layers are muted. The template layer is hidden or 

printed when the illustration is used in a layout programme like InDesign 

or QuarkXPress.

You may use templates to build new documents with reusable format-

ting and design features. For instance, you may construct a template with 

the necessary artboard size, view settings (such guides), and print choices 

if you need to design a number of business cards with a similar style. The 

template may also include particular collections of colour swatches, brushes, 

and graphic styles as well as symbols for typical design components (such 

as logos). Templates for business cards, letterhead, brochures, envelopes, 

certificates, labels, greeting cards, postcards, and websites are among the 

many that Illustrator has. When a template is chosen using the New From 

Template command, Illustrator produces a new document with the exact 

same content and document settings as the template while erasing the 

template’s original file.

Making a template gives you a lot of flexibility for modification and 

teamwork within your business. A template may be modified by anybody 

who opens it without risking mistakenly overwriting the original version. 

For instance, it would be simple to build a template for a business card or a 

postcard that follows certain rules for the positioning of text.

How can a template layer be created?
A template layer can be used in two different ways. When importing raster 

artwork into Illustrator as a template, this is the most popular technique to 

generate a template layer. Select Place > File. Select the artwork you wish 

to import in the Place dialogue box, check the Template box in the lower-

left corner, and then click Place. To ensure that you can see any paths you 

draw over the file, it is put on a locked layer and muted to 50% by default.

Converting an existing artwork layer into a template is the second 

approach to creating a template layer. In the Layers panel, double-click a 

layer name. Select the Template check box in the Layer Options dialogue 

box that opens, and then click OK. The layer is automatically locked, and 

the layer symbol in the Visibility column switches from the Visibility icon 

to the Template icon. It won’t be darkened if you turn vector artwork into 

a template layer.
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What are the steps to be followed to create a new template?
Step 1: You must open a new or existing document as your initial step.

Step 2: Any of the following techniques to modify the document:

•	 When you create new documents using the template, you may configure 

your Document window to appear how you choose. The degree of mag-

nification, scroll position, ruler origin, guidelines, grids, crop regions, 

and View menu choices are all included in this.

•	 You’ll now need to add any artwork that suits your needs from the tem-

plate by editing it or just adding it. Any current swatches, styles, brushes, 

or symbols that you don’t wish to keep should be deleted.

•	 Additionally, you may import pre-made colours, styles, brushes, sym-

bols, and actions from a number of Illustrator-supplied libraries.

•	 You may create any type of graph design and add it to the Graph Design 

dialogue box. Additionally, you may import premade graph designs.

•	 In the Print Values dialogue box and Document Setup dialogue box, 

choose the desired options.

Step 3: Choose Save As Template option under File.

Step 4: Choose a location for the file, type a filename, and then click on 

the option Save in the Save As dialogue box. The file is saved by Illustrator 

in the AIT (Adobe Illustrator Template) format.

What are the advantages of using a template?
Time savings
A finalised template is just that—hence the name. You log in and contribute 
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your own stuff, such as text and media. This benefit doesn’t just benefit the 

buyer; the designer may also get time savings by employing completed 

templates for his clients.

Quicker selection
Customers with few original design ideas will find it much easier to use 

templates. After all, they are immediately given alternatives. Humans 

are visual beings who make judgments more quickly if they can see their 

options. This benefit can also be used by the designer. He may present a 

variety of various templates to his clients, obtaining a precise layout choice 

immediately away. In turn, the designer has to work harder.

Cost-saving
No matter how you look at it, using a pre-made template is less expensive 

than hiring a designer. By using pre-made themes for his clients, the designer 

also saves money. Typically, this enables him to provide services for a lot 

less money, maybe earning commissions he would not have received at 

higher costs.

More rapid switching
In addition to the advantages listed above, there is another one. It is simple 

to change the design that is based on a template. After a few years, you 

probably won’t want to abandon a costly bespoke design because the pain 

is still too great. assuming you didn’t have a person bend the template till 

it resembles a completely original design.

What are the disadvantages of using a template? 

Unoriginal
There’s a good probability that you won’t be the only person utilising one 

of the Adobe Illustrator templates. You shouldn’t have to use one of the 

pre-existing templates when creating a design that has to be distinctive. If 

your audience has seen the same format a lot, using templates might make 

it harder to separate from the crowd and can make you appear unoriginal.

Basic
The quality of the readily available templates is quite subpar. Some tem-

plates may contain subpar graphics or visual components and rely heavily 
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on you to fill in the majority of the blanks. If you’re wanting to showcase 

your work or your abilities, such as on a photography portfolio website, 

you could discover that utilising template results in a final product that is 

less remarkable than something you might have created entirely on your 

own. This can work against you.

Unchallenging
You won’t reap the benefits of becoming familiar with the ins and outs of the 

Adobe Illustrator tools you’re using if you rely on templates to put together 

your projects, whether they be banners for the workplace or personal 

websites. Building your own components from scratch encourages you to 

become knowledgeable about the functions and principles of the platform 

in question. Utilizing a template-based approach might prevent you from 

learning about and investigating the software as much as you otherwise 

would if you are using the necessary tools for work.

Restrictive 
Templates are often created to make it as simple and quick for you to pro-

duce results as possible, but frequently the modification possibilities are 

constrained, constraining what you can do with your files. It’s possible 

that you won’t know how to make the essential tweaks and alterations to 

the template to make it your own if you aren’t familiar with all the aspects 

in question. In other instances, the template won’t allow for the level of 

customization you desire, leaving you with a finished product you’re not 

content with.

What are the major alternatives to Adobe Illustrator?

Inkscape
One of the oldest and most reliable free vector drawing programmes 

available is Inkscape. It was initially released 15 years ago, and thousands 

of devoted users all across the world continue to build and maintain it 

today. Its users may produce the graphic design of a professional calibre 

that is indistinguishable from costly vector graphics programmes like 

Adobe Illustrator because of its effectiveness and power. The programme 

is available for free download at inskcape.org on the official website, so 

you can start developing it right now. This makes it the perfect graphics 

application for ambitious and beginning designers. Professional 
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designers all over the globe use Inkscape to create high-quality designs 

at affordable prices.

Pros

•	 Excellent format support 

•	 Comprehensive toolset 

•	 Regular updates

Cons

•	 May exhibit performance sluggishness

Vectr
Vectr’s goal is to provide an easy-to-use and easy-to-learn Adobe Illus-

trator substitute. It is the perfect tool for novices or people who simply 

need to make simple designs for logos and drawings because it can be 

downloaded for free as a desktop programme and used in-browser. It 

provides simple vector editing tools, including text, several design levels, 

and the ability to create shapes. The generated designs can be exported 

locally or stored online.

Pros

1. 	 Simple to Use and Learn

2. 	 solutions for high-end vector graphics

3. 	 An application that is simple and clear
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4. 	 Numerous Design Features and Tools

5. 	 Numerous clipart patterns, calendar symbols, stars, lightning bolts, and 

arrows are examples of advanced features.

6. 	 Every project created using Vectr is automatically saved online.

Cons

Mostly good for vector art purposes, otherwise not.

CorelDraw
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The quickest illustrator tool on the market is known as CorelDRAW. Illus-

trator is an all-in-one design and layout programme that runs on Windows, 

iOS, Mac, iPad, and even your phone. Designing is made much simpler by 

the availability of a multipage view and a multi-asset export. With Corel-

DRAW’s cutting-edge collaboration tool, team members may give comments 

and input directly in the design file. CorelDRAW is the most potent Adobe 

Illustrator substitute in terms of graphic design skills.

Pros

•	 Multiple file types, including PSD, DXF, EPS, and TIFF, among others, 

may be shared and exported.

•	 The instructional films are in-depth and highly beneficial.

Cons

•	 Since some of the supplied software’s components and functionality 

must be used to function, it is not entirely offline.

•	 The freehand brush is challenging for users to utilise.

Figma
Free to use, Figma is a collaborative illustration programme. Figma reduces 

the amount of manual resizing and alignment with its auto-layout capa-

bility. You may also add plugins using it. It is a cloud-based design tool that 

enables you to view your work through the internet from any location. It 

works with both Windows and iOS.
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Pros

•	 Users don’t need to spend money on several tools because this one has 

all they need for developing websites.

•	 Using Figma, several team members may collaborate on the same pro-

ject at once.

•	 contains every tool necessary to produce a prototype design.

•	 As it’s cloud-based, you may access data from anywhere.

Cons

•	 Runs slowly on bulky prototypes; as a result, a graphics card and ade-

quate RAM are needed.

•	 need an internet connection; it is not offline-compatible.

•	 The module in Figma lacks global colours.

Affinity Designer

Affinity Designer, which was introduced in 2014 and is compatible with 

Windows, macOS, and iOS, is a well-liked substitute for Adobe Illustrator. 

The UI of Affinity Designer, which enables users to create in three different 

personas—Pixel Persona, Designer Persona, and Export Persona—is its 

strongest selling point. Affinity Designer is a hybrid of Adobe Illustrator and 

Adobe Photoshop, and seasoned Adobe users will appreciate how simple 

it is to transition between vector, pixel, and export modes.
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Pros

•	 Make precise designs

•	 Over 1,000,000% Vector and Zoom Pixel in One Workflow

•	 Produce stunning vector artwork

•	 Real-time pixel preview

•	 Animated Symbols

•	 Outline views and split-screen views

•	 Optimizing UI, Web, and App Designs

•	 Precision Dynamic Guides

•	 Options for Advanced Grid Snapping

•	 Perfect Geometry

•	 Brilliant Colors

•	 Brush Stabilization in Game Design

•	 Impressive Text for Responsive Designs

•	 Numerous Artboards

•	 Management of Advanced Memory System Assets

•	 Support for Advanced Files

Cons

•	 The functionality of layers might be unclear.

•	 There is no auto trace option.

Sketch
A 30-day trial version of Sketch, a macOS-based illustrator, is available 

for free for users to try out. Vector editing, Boolean operations, arithmetic 

operations, and Variable and OpenType fonts are just a few of its incred-

ible capabilities. Sketch is a collaborative tool that enables users to share 

libraries of symbols, text and layer styles, and colour variables with other 

users and work on the same project at the same time.

Pros

•	 Sketch has revolutionised the design industry, and its user base is 

expanding daily. If you ever run into trouble, there are several forums 

and Facebook groups that give assistance.

•	 They have a top-notch development staff. It makes sense because they 

create the go-to programme for user-centred design. More and more 

problems are fixed and wonderful core features are delivered with each 

update—and there are a lot of them.
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Cons

•	 Your machine seems to suffer a lot after using Sketch. Sketch can sig-

nificantly slow down older computers. The software fails to handle files 

as Adobe products can, even on the fastest Macs.

•	 Plug-ins appear to be required.

Pixelied
When they need to produce images fast, many Illustrator users turn to 

programmes like Canva. And Pixelied is a popular Canva substitute on 

the market. Although it lacks Illustrator’s extensive vector editing tools, 

the application offers a wide variety of materials, vector icons, templates, 

and pre-made design options. To employ your creations, you may submit 

vector files from Adobe Illustrator and Photoshop to Pixelied. It is a web 

application that runs on the cloud.

For individuals who are new to the world of photographic editing soft-

ware or only require the most basic functionality, Pixelied is a fantastic 

choice. If you’re searching for something more complete, this might not be 

the greatest option, but if you only need the essentials, like making social 

media posts and featured blog photos, Pixelied excels at those tasks.

Pros

•	 lovely pre-made templates
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•	 Drag and drop capability

•	 Simple and transparent user interface

•	 really quick loading

•	 feature for vector upload

•	 has a free membership

Cons

•	 Limited credits for background removal

•	 Limited number of examples

•	 Saving time with a slow mockup

Canva

Canva is one of the most powerful online graphic design tools that is avail-

able right now. With an easy to use interface and a powerful set of tools, it 

has become a mainstay in the toolkit of many professional and amateaur 

graphic designers accross the globe. If the option of some people is to 

considered, then this tool, with a bit more tweaking to the set of features 

offered, can be a full fledged replacement for Illustrator, and that is to say 

a lot, especially considering the fact that it has been around for a shorter 

time than Illustrator.

Pros

•	 Easy to use interface

•	 Vast selection of tools for beginners

•	 A healthy selection of free and paid templates for all purposes

Cons

•	 Not powerful enough for professional designing work

•	 Lmimted  selection of export formats

Conclusion
One of the top platforms now on the market is Adobe Illustrator. If you 

are unsure about whether to utilise design templates or not, we advise 

using them only when absolutely necessary. Otherwise, design every 

artwork from the ground up. Utilize many techniques to carry out the 

resolution that is in your thoughts. This will enable you to develop your 

artistic abilities. 
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